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Chapter 1

Recall Guide

1.1 Documentation for Recall

Documentation for Recall

------------------------

This document describes the usage of Recall and how to make your own

customized project of events. Please also read the documentation for

ReConvert, describing how to convert your project between different

formats.

Description

Credits and requirements

Copyrights

Installing

Unstalling

Running the programs

Using Recall Preferences

Using Recall

Source

Known bugs

Future developments and plans

Troubleshooting, Tips & Tricks

History

How to contact the author

Users with a 68000 CPU or NO harddrive

About MagicUserInterface
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1.2 Description

Do you keep forgetting about birthdays, anniversaries and other important

events?

Well, there are plenty of public domain products on the market that will

prevent that from happening.

But, do you also want to

- keep track of the remaining days to important events?

- keep track of the days since important events happened?

- automatically start certain programs depending on the date and time?

- be reminded every # day (e.g. every 14th day)?

- be reminded # days before or after the event

- be reminded once a day, every time you boot, before or after a certain

date, before or after a certain hour or minute?

- be reminded about events until you acknowledge them?

- be reminded with requesters, alerts or practically anything that can be

displayed on an Amiga-monitor?

- display unlimited lines of text in the same requester/alert (only

limited by the screen’s resolution and memory)

- group different events in the same requester or alert?

- keep a simple database of the birthdays of family and friends?

- let your Amiga keep track of how old people are by insterting the date

of birth in the middle of the string where you want to display the age?

(E.g. the text "Adam is {080570} years old today" will be displayed as

"Adam is 23 years old today".)

- make advanced events which are displayed for example after 21:00 every

3rd day the first 7 days of every 2nd month the next 4 years?

- combine all of the attributes mentioned above in the same event?

- enter these events in an easy-to-use environment and without the need of

programming-knowledge, just by entering the desired text and pressing a

few buttons?

Well, then you will find this program extremely useful, because Recall

will do exactly that for you! It is an easy-to-use, intuition-based

utility for the absent-minded!
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1.3 About Recall and Credits

NAME: Recall/Recall Preferences/ReConvert

VERSION: V2.3

PROGRAMMER: Ketil Hunn

PLACE: Fredrikstad / Molde - DHMolde 1993-1994, Norway

COPYRIGHT: All binaries and docs are © 1993-1994 Ketil Hunn

DISTRIBUTE: Freely Distributable, Public Domain

MAIL: ketil@lyr.dhmolde.no

hunn@dhmolde.no

TOOLS: SAS/C V6.3

REQUIREMENTS: Any Amiga with WB2.0+

At least 1Mb free memory

Needs WB2.1+ in order to be localized

MUI V1.4+

ReqTools.library (optional)

MUI: Although, MUI is required to run this program, it is not

included in this archive as it would have made the archive

too big. The MUI-package is available on FTP sites, various

BBS’s and Public Domain disks.

On AmiNet mirrors:

Path: /dev/gui/

File: MUI20USR.lha

REQTOOLS: The usage of ReqTools.library is optional. This library is

not included in this archive. It is freely distributable and

you should be able to find it on any FTP site, BBS or PD-

disks.

TRANSLATIONS: The Deutsch catalogs were translated by Dirk Böhmer.

The Nederlands catalogs were translated by Frank Breedijk

The Italiano catalogs were translated by Giorgio Demenego.

The Suomi catalogs were translated by Juha Kettunen.

The Norwegian catalog was translated by me.

The suomi.language is copyrighted to Tomi Blinnikka

(I couldn’t get in touch with you, but I have included it

anyway... Hope you don’t mind!)

GENERAL: This package was developed on an A3000 25MHz with 6Mb RAM,

1950 multisync monitor, 105Mb harddrive, 3 drives and a Nec

P20-printer. All software were running under WB3.1.

The Graphic User Interface (GUI) was created using the great
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MUImaster.library - Copyrighted 1992/93/94 Stefan Stuntz.

The ReqTools.library is copyrighted to Nico François.

BETATESTERS: Giorgio Demenego

Michael Zielinski

Frank Breedijk

Frank Duerring

Philip Graham Meyer

Nuutti Merilæinen

Juha Kettonen

Janne Simonen

THANKS TO: Thorsten Gau for the SBasePro4 script and all those who sent

me suggestions and bugs, and of course the translators and

the betatesters. I would also like to thank all those who

dropped me a note on my e-mail address. The response has

been enormous. If this keeps up, I’ll have to hire a

secretary :-)

See also How to contact the author

1.4 Copyrights

This application is freely redistributable as long as the archive is not

modified in any way.

Think twice before you:

- SPREAD or DELETE parts of this program. Some people actually read the

docs (you are, at the moment!). All of the following files and

their icons MUST be in the archive:

Install/Install : Installer-script for harddrive-users

Unstall/Unstall : Removes the application from a system

Recall : Main program

Prefs/Recall : Preference-program

Tools/RecallConverter : Program to import and export projects

Docs/Recall.guide : Documentation in AmigaGuide-format

Docs/Recall.ASCII : Documentation in ASCII-format

Docs/ReConvert.guide : Documentation in AmigaGuide-format

Docs/ReConvert.ASCII : Documentation in ASCII-format

Recall.prefs : An example-project

Locale (dir) : Contains the language catalogs

Scripts (dir) : Various scripts for processing data.

- CRUNCH this program and then spread it. Some decrunchers use a lot of
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memory and not all of the users have all that memory available! Most of

the Amiga-owners dislike colorcycling pointers and screens, and not all

crunchers have available decrunchers, so the user may not be able to

decrunch the program if she/he wants to!

- SELL or INCLUDE this in a commercial package! This program is dedicated

to the Amiga society and is placed in the Public Domain! If you charge

more than a reasonable copy fee for this package, people are sure to

find out about you sooner or later, and that will certainly be the end

for you in the Amiga-scene!

- BUY this program. You have been swindled! If you actually read this

text, the seller must be pretty dumb not removing this text before

selling it to you (he probably assumes you’re just another lamer that

can’t read!).

- USE this program. In spite of several test, no warranty is made that

there’s no more bugs in this application. You use this program at your

own risks! I will not under any circumstances be liable for any damage,

direct or indirect, resulting of the use of any programs in this

package. If Recall forgot to remind you about some events, DO NOT BLAME

ME - if you were not so absent-minded you wouldn’t be needing an utility

like this in the first place: You can either trust Recall and keep on

with your life, or quit using Recall and start to remember things...

- READ this document. I will not be liable for any damage this document

may have caused you; english is not my native language and I guess this

document is full of misspellings and misunderstandings. You can either

live with it and keep on reading, run this through a spellchecker or

stop reading. The program is quite easy to use and needs no

explanations.

- LIKE this program. You may want to send me a postcard if you do, just

telling me how much you like it. Really, I wouldn’t mind that at all,

but it is no obligation. You may also drop me a note on the internet.

The address will be at the end of this document.

1.5 Installing

I am not going to go through the whole installation process here, since

most of you are already familiar with Commodore’s Installer. Just

doubleclick on the install-icon, and the program will install itself

automatically (just answer a few questions...).

Beginning with version 2.1, the installation-script is localized. Just
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click on the preferred language and the installation and it’s questions

will be given in that language.

The script needs Commodore’s ’Amiga Application Installation Utility’

(Installer) in order to run. This is not included in this package because

it is copyrighted to Commodore. The Installer utility is shipped with

WB2.1 and higher.

If not available, please copy the program and its icon as follows:

Recall -> SYS:WBStartup/

Prefs/Recall -> SYS:Prefs/

Tools/RecallConverter -> SYS:Tools/

Recall.prefs -> ENVARC: and ENV:

Docs/<guide files> -> HELP:english/

Unstall -> Wherever you like...

If you do not install Recall and ReConvert to the listed drawers, Recall

Preferences will not be able to find them, and you will not be able to

test projects nor import and export projects.

If you do not install the guide files to the listed drawer, you will not

be able to use on-line help from Recall Preferences or ReConvert.

1.6 Unstalling

Doubleclicking on the icon named UnstallMe!, will execute a script to

remove the Recall package from your harddisk (all actions must be

confirmed!).

1.7 Running the programs

Both programs may be run from Shell or from Workbench by doubleclicking on

their icons.

An absent-minded person like yourself, is also capable of forgetting to

start Recall every day, so the most secure way of being reminded of

events, is to copy Recall to your SYS:WBStartup drawer. This way it will

check for events every time you boot your machine.

If Recall is run with no parameters it will automatically look for the

project "ENVARC:Recall.prefs". Any parameters will override this.

"Recall test.script" forces Recall to open the script "test.script"

instead of "ENVARC:Recall.prefs".
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1.8 Using Recall Preferences

This is where all the work is done and where the you create your

customized project. The window of Recall Preferences is dominated by two

groups of objects, each group containing a listview. The listview in the

Event-group contains all the events you want to be reminded of, while the

listview in the Text-group will contain the event’s textlines or commands.

The program can either be controlled by mouse or keyboard. Most gadgets

have an underlined character, meaning that a hit on this character on the

keyboard are equal to clicking on the button with the mouse. The two

Delete-gadgets do not have short-cuts, to prevent you from accidentally

delete an event or a text. They may however be controlled from keyboard

by cycling you through the gadgets with TAB until the desired gadget is

highlighted and then pressing return. Even the listviews may be control-

led from keyboard. Whenever a listview’s stringgadget is active you may

select the previous or next item in the list by using the arrow buttons.

Create an event

Duplicate an event

Delete an event

Change the placement of an event

Purge events

Sort the list of events

Set the date of an event

Set the time of an event

Finetuning the date and time

Setting the number of days before or after

Making a repeating event

Setting the date and time to now

Clearing the date and time

Set the type of an event

Selecting a command from a filerequester

Set how often the event will be displayed

Selecting the method of field calculation

Add text to an event

Duplicate a textline

Delete a textline

Change the placement of a textline

Sort the list of texts

Save a project of events

Test a project of events

Cancel all changes and quit

Saving the size and position of windows
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1.9 Creating an event

You can add an event to the list by clicking on the Add-gadget. The

stringgadget above it will become activated, letting you enter the name of

the event. The length of the name is limited to 30 characters. The

event’s name should be short, consistent and describe the type of event

well. If you have many events which reminds you about e.g. birthdays, a

good name for all these events could be ’Birthday: <name>’, as this would

provide a better visualization of the data and make it a lot easier for

you to seek through the list of events.

The name you have entered, will only be added to the list if you press

return. Failing to do so, will cancel the creation of the new event.

Pressing return will add the new event at the bottom of the list. If the

bottom of the list is not showing, it will automatically jump to the

bottom to show the new event. The new event will be highlighted to

indicate that it is the current active event.

The number of events are only limited by the available memory.

1.10 Duplicate an event

You can duplicate an event by selecting the desired event and clicking on

the Copy-gadget. All attributes as well as all textlines of the event

will be duplicated. The new event will appear just below the source. The

stringgadget will be activated, allowing you change the name of the

destination event. The destination is highlighted to indicate that it is

the current active event.

1.11 Delete an event

You can delete an event by selecting the desired event and clicking on the

Delete-gadget. All attributes as well as all textlines of the event will

be deleted. The next event in the list will become the current active

event.

If the project has been previously saved, the deleted event can be

restored by selecting Edit->Last saved.
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1.12 Change the placement of an event

When running a project, the events will be run in priority from top to

bottom unless the menu-item ’Group events?’ is checked. So moving an

event up, will mean that it will be shown earlier when running the

project.

Up

Moves the current active event up one position.

Down

Moves the current active event down one position.

Top

Moves the current active event to the beginning of the list.

Bottom

Moves the current active event to the end of the list.

See also Settings->Group Events?

1.13 Purge Events

When the same project is used for a considerable period of time, it may at

the end contain several events which are expired or said in other words,

contain events which will never be displayed. So instead of going through

the entire list, looking for events that is no longer needed, you simply

click on the Purge-gadget, and the machine will do the checking and

deleting for you!

See also Settings->AutoDelete events?

1.14 Sorting the list of events

There are three methods of organizing the list of events. You can either

sort the events alphabetically, sort them by date or by changing their

placement individually.

The list of events will be sorted whenever clicking on the Sort-gadget.

The routine used, is determined by the settings in the settings-menu.

When sorting by date, the events with no date at all will be appearing at

the beginning of the list, then the events with one or more components of

the date replaced by ’**’ will appear and last, the events with a fixed

date.

See also Settings->Sort by.
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1.15 Setting date an event

The date of an event is now set from a calendar, very much set up like the

Commodore’s own Time Preferences. This calendar can be opened by pressing

the Edit-button.

The textwindow on the left to the Edit-button will always show the date of

the event. When no date is set, the date will be substituted by a text

saying ’Every day’, and when no time is set, the time will be substituted

by a text saying ’All day’. When a component of the date is of no

importance, it will be displayed as two or more ’*’, meaning that any

value will satisfy.

To set the day of an event, simply click on one the numbered gadgets in

the calendar-window. The selected day will be highlighted and displayed

in the date field. If you want the event to appear on any day, please set

the day to ’0’, zero.

The month is set by cycling through the month-cyclegadget until the

desired month is activated. If you want the event to appear every month,

please select the item ’Any month’.

NOTE! that selecting ’Any month’, will mean the CURRENT MONTH, thus an

event set to BEFORE ’01/**/****’ will never be displayed! If you want the

event to be shown x days before the 1st of every month, please set it up

like this: x-1 days before the last day in the month or i.e. after 25th.

The year of the event is set by entering the desired year in the

integer-gadget next to the month-cyclegadget. If you want the event

to appear every year, enter a zero or nothing. Entering a number

which length is less than four, will cause the event to be displayed

each year the given year match with the current year. In other words,

entering year=’3’ (displayed as ’***3’) will display the event every year

that ends with ’3’.

See also How to tune the date and time

Set the time of an event

Setting the time and date to now

Clearing the date and time

1.16 Setting the time of an event

Setting the time is just as simple as setting the time under Commodore’s

Time Preferences. Just drag the sliders to the desired level. The

selected hour and minutes will be shown in the main window. Setting any

of the sliders to the bottom level will replace its value with ’**’,

meaning that any hour/minute will do.

See also How to tune the date and time
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1.17 Tuning the date and time

It may be times when you do not want the events to appear on a specific

date or time, but rather before or after. This can easily be achieved by

setting the cycle-gadgets at the top of both date- and time-groups in the

calendar. The default value is ’Exact’.

Exact

The event will appear ONLY at the given date or time. If you do not turn

your machine on that day, you will never see the event!

Before

The event will appear only BEFORE the given date or time. If the

selected date is ’07.**.1993’, the event will appear on the first 6 days

every month during 1993. If the selected time is ’11:00’, the event will

appear between ’00:00’ and (not including) ’11:00’.

After

The event will appear only AFTER the given date or time. If the

selected date is ’07.06.1993’, the event will appear every day from

’08.06.1993’ to eternity. If the selected time is ’11:00’, the event will

appear between ’11:01’ and (including) ’23:59’.

See also Setting the number of days before or after

Making a repeating event

1.18 Setting the number of days before or after

Allows the user to set the interval of days, and the event will only

be displayed during that interval. Let’s say the date is set to

’07.**.1993’, days set to value ’2’ and the cyclebutton selected is

Before, the date will only be displayed on the 5th and 6th every month

during 1993, in other words two days before the 7th day of any month.

This gadget becomes available only when the date is set to Before or

After.

1.19 Making repeating events

Allows the user to set the interval of repeating days. If for example the

field contains the number ’14’, the event will be displayed every 14th

day before/after the specified date.

This gadget becomes available only when the date is set to Before or

After.

Another way of making a repeat event, is of course by setting one or more

of the date’s components to a zero (indicated by ’**’ in the date).

See also Setting the date of an event

Setting the time of an event
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1.20 Setting the date and time to current values

By pressing the gadget ’Now’, the date and time of the event will be set

to the current date and time.

1.21 Clearing the date and time of an event

By pressing the gadget ’Clear’, the date and time of the selected event

will be reset to default values, meaning that the event will appear "Every

day - All day".

1.22 Selecting the type of event

In what way an event will appear, is determined by which type of event is

set for that event. You may select between these modes:

Requester

All texts will be displayed in a standard requester with an OK-button.

Selecting OK will tell Recall to proceed to the next event.

If the menu-item ’Settings->Confirm requesters?’ is checked, the re-

quester will also have a Cancel-button. Selecting Cancel will tell

Recall not to show the event more that day.

If the menu-item ’Postpone requesters?’ is checked, the requester will

also have a ’Postpone’-button. Selecting this button will postpone the

event until next time you run Recall, even if the event is of Daily type!

It will keep reminding you until you press ’OK’ or ’Cancel’.

The maximum number of lines which may be displayed is only limited by

the screens resolution and font. The requester will automatically adjust

to the font used by your system.

Alert

All texts will be displayed using a standard RECOVERY ALERT. The alert

will be opened on a 640*200 screen on a NTSC-machine or a 640*256 screen

on a PAL-machine. The font used will always be Topaz8. The frame of the

alert will be automatically adjusted to fit the number of lines shown

and all lines will be centred. Pressing either left or right

mousebutton will continue. If ’Settings->Confirm alerts?’ is checked, the

alert will contain a line at the bottom of the alert announcing that

pressing the left mousebutton will continue and pressing the right

mousebutton will cancel the event. Selecting cancel will tell Recall not

to show the event more that day.
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Execute

All texts will be run as if they were typed from Shell. If several

programs is requested, they will be run after each other in priority

from top to bottom.

Running larger batch-programs can be done easily by entering "execute

<filename>". Recall also accepts remarks and ’execute <filename> ;

remark’ will work without problems.

Instead of typing in your commands, you can select them from a file-

requester. Just click on the GetFile-gadget to the left of the string-

gadget and select the file you want to run.

See also How often the event will be displayed

Selecting a command from a filerequester

1.23 Selecting a command from a filerequester

Instead of typing in the programs you want to execute from Recall, you can

simply click on the GetFile-gadget to the left of the stringgadget.

Clicking this button will bring up a filerequester, allowing you to select

the command you want to run. The name of the selected file will be copied

to the stringgadget and the cursor will be positioned at the end of the

string, allowing you to enter any parameters.

1.24 Selecting how often the event will be displayed

The Show-cyclegadget determines how often the event will appear. Several

options are available:

Always

The event will be displayed every time Recall is run.

Daily

The event will only be run the first time Recall is run that day, in other

words; only once a day.

Never

The event will never be displayed. Useful if you want to temporarily

prevent an event of being displayed.
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1.25 Setting the method of calculation

This cycle-gadget determines which method will be used when calculating

fields. If the texts do not contain any fields, this cycle-gadget has no

effect.

Years

This method will return the number of years between the current date and

the date in the date field.

If the text of the event is "Adam is {080570} years and Dick is {310165}

years old today", it will be displayed as (assuming the year is 1993):

"Adam is 23 and Dick 28 years old today".

When this method is used, it is not necessary to enter the whole date in

the calculation fields. "Adam is {****70} years and Dick is {****65}

years old today’ will result in the same message. It is, however,

advisable to always enter the full date in events.

Days

This method will return the number of days between the current date and

the date of calculation field.

Text containing "{020693} days to my exam" will for example be

displayed as "4 days to my exam".

NOTE! Recall will always assume that the given year is in the 20.

century. Attempting to calculate the remaining days to year 2000 will

fail, since {010100} will be interpreted as 01.Jan.1900... :-(

See also Adding text to an event

1.26 Adding text to an event

You can add text to an event by selecting the Add-gadget. The string-

gadget will be activated, allowing you to enter the desired text. The

length of the text is limited to 255 characters. The text will not be

added to the list of texts until you press the return key. Failing to do

so, will cancel the creation of the new text. Although the length of text

can be as much as 255 character, you should keep in mind that alerts and

requesters with standard Topaz8.font are limited to a width of 77

characters.

The lines of text will either be displayed in a requester or alert, or

they will be executed, depending which type of event you are adding text

to.

Another nice feature of Recall, is that you can include a date field
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within the textlines. These fields will be calculated during the

execution of a project and the resulting value will be displayed instead

of the date field. There is no limit to the number of fields in one line

of text. The format of the date field is {DDMMYY} and MUST be exactly

in that format! Notice the bracket parenthesis surrounding the date field

- they can not be omitted! A few examples to clarify (assuming the date

is 17.11.93), the original on the left and the displayed outcome to the

right:

"I am {080570} years old" -> "I am 23 years old"

"{120294} days left to the Olympic Games" -> "87 days left to the..."

Notice how the first line displays the years, while the second line

displays the number of days. The result of the date field is determined

of which method of calculation is selected.

See also Selecting the method of calculation

1.27 Duplicating a textline

You may duplicate a textline by selecting the desired text and clicking on

the Copy-gadget. The destination will appear just below the source and it

will be highlighted to indicate that it is the current active textline.

The stringgadget will be activated, allowing you to change the text.

1.28 Deleting a textline

You may delete any textline by selecting the desired text and clicking on

the Delete-gadget.

1.29 Changing the placement of a textline

The list of texts may be organized in either two ways, by sorting the list

alphabetically or by individually change each line’s position.

Up

Moves the current active text up one position.

Down

Moves the current active text down one position.

See also Sort the list of texts

1.30 Sort the list of texts

You can sort the list alphabetically by clicking on the Sort-gadget,

changing the order in which they will be displayed.

See also Changing the placement of a textline
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1.31 Saving the project and quitting

When clicking on the Save-gadget, Recall Preferences saves the current

project under the default name and exits.

The project can be saved without exiting, by selecting Project->Save from

the Project menu. If you want to save the project under a different name

you can achieve this by selecting Project->Save as...

The settings is always saved with the project.

See also Using the Project menu

Cancel

Settings

1.32 Testing a project

When creating a new project of events, there is sometimes a wish to try

things out before saving to disk. This can be achieved by clicking on the

Test-gadget or by selecting the menu-item Project->Test.

When selected, Recall Preferences will run through the list of events and

display them according to their attributes. Recall must be resident in

the SYS:WBStartup/drawer for this to work.

See also Project->Test

1.33 Cancel all changes and quit

Clicking on the Cancel-gadget will terminate the program without question,

unless the Settings->Confirm? menu-item is checked. All changes done to

the project will be lost.

See also Settings->Confirm?

Save

1.34 Saving the position and size of windows

To keep the size and position of Recall Preferences’s windows permanently,

you must first start Recall Preferences and select the desired size and

position of both main and calendar window. Then start MUIPrefs and click

on the Save-gadget in MUIPrefs-window. That’s it, and that’s that...

When resizing or changing the position of Recall Preferences windows, the

size and position will saved temporarily and used the next time Recall

Preferences are started. However, if these changes are not saved, they

will be lost when rebooting or turning off your machine and Recall

Preferences will use it’s default size and position on next startup.

See also the documentation of MUIPrefs.
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1.35 Describing the Project menu

New...

Selecting this item will clear the list of events and enabling you to

start from scratch designing your new project of events. Remember to save

your changes...

Open...

Brings up a filerequester and lets the user select a new project to be

loaded. The new project will replace the current project. Remember to

save you changes...

Append...

Brings up a filerequester and lets the user select a project to be joined

with the current project. The new project will appear at the end of the

current project.

Import -> ASCII...

Brings up a filerequester and lets the user select an ASCII file which

will be loaded and converted into a Recall project. ReConvert must be

located in SYS:Tools-drawer. See also the ReConvert documentation for

further details on converting projects.

Import -> Recall V1.x...

Brings up a filerequester and lets the user select a Recall V1.x project

to be imported. The ReConvert must be located in SYS:Tools-drawer. See

also the ReConvert documentation for further details on converting

projects.

Save

Saves the project to disk under the default name, without exiting the

program. The settings are saved with the project.

Save as...

Lets the user save the project in a different name. The settings are

saved with the project.

Export ASCII...

Exports the current loaded project as an ASCII file.

Converter

Selecting this item will run ReConvert. The program must be located in

your SYS:Tools-drawer.

Test project

Runs the current project. Recall must be located in the SYS:WBStartup.

Iconify

Closes all open windows and iconifies the program to an icon placed on the
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workbench screen. The program may be un-iconified by double-clicking on

the iconified icon or by pressing ’Show Interface’ from the Commodore’s

Exchange program.

About...

Loaded with interesting information. Try it out immediately!

Quit

Terminates the program. All edited events will be lost. Remember to save

your changes...

Other menus: Edit

Settings

1.36 Using the Editmenu

Last saved

Restores the last saved project under the default name to memory. All

edited events will be lost! Remember to save your changes...

Other menus: Project

Settings

1.37 Using the Settingsmenu

Group Events?

When this menu-item is checked, events of the same type will be grouped

together in the same requester/alert/execute-block.

Flash Screen?

When this menu-item is checked, Recall will flash/beep (or both at the

same time, depending on the configuration set by Commodore’s Sound

Preference) before an event is executed or displayed.

Confirm requesters?

When this menu-item is checked, Recall will add a Cancel button to all

requesters. Selecting Cancel in requesters will tell Recall not to show

that specific event more that day. If events are grouped and the user

selects cancel, ALL events which were displayed will be cancelled!

Confirm alerts?

When this menu-item is checked, Recall will add a line at the bottom of

all alerts, telling the user to press left mousebutton to continue or

press the right mousebutton to cancel the event. Selecting cancel will

tell Recall not to show that event more that day. If events are grouped

and the user selects cancel, ALL events which were displayed will be
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cancelled!

Confirm executables?

When this menu-item is checked, Recall will always ask before executing

any commands. Selecting ’OK’ will carry out the command(s). Selecting

’Cancel’ will cancel the execution of all grouped executables.

Postpone requesters?

When this menu-item is checked, Recall will add an extra button to any

requester. Pressing this button will postpone the event and force it to be

displayed every time until you press ’OK’ or ’Cancel’, even if the event

is a daily event! If events are grouped and the user selects Postpone,

ALL events which were displayed will be postponed!

Use ReqTools?

When this menu-item is checked, Recall will open and use the

ReqTools.library instead of standard System’s EasyRequests. If the

library is NOT available, Recall falls back to the system’s default

requesters. Using the ReqTools library enables Recall to centres it’s

requesters and let the requesters follow the mouse. If NOT checked, all

requesters will appear at the upper left corner of the screen, unless you

have installed a patch for requesters.

Centre requesters

When this menu-item is checked, Recall will centre all requesters on the

default public screen. This menu-item will be ghosted if ’Use ReqTools?’

is not checked.

Confirm

When this menu-item is checked, all actions in Recall Preferences that

alters the project, must be confirmed before they are executed.

AutoOpen Calendar

When this menu-item is checked, Recall Preferences will automatically open

the calendar on startup. This option is for users that run Recall

Preferences on an interlaced screen and wish to have the calendar open all

the time.

AutoDelete Events

When this menu-item is checked, Recall will automatically remove all

expired events from the project upon startup.

Sort by

Lets the user select the sort-criteria used when sorting events.

Other menus: Project

Edit
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1.38 Using Recall

This is the main program. If started without any argument, the program

will look automatically look for the project ’ENVARC:Recall.prefs’.

Any given parameter will override this. Depending on the type of the

event, the event will appear in several ways.

See also Setting the type of an event

Starting Recall

1.39 Source

The source is not included anymore :-(

1.40 Known bugs and other strange occurrences

Recall:

- The alert-type may crash on some machines. Switch to requester if this

happens...

Preferences:

- No known bugs

See also Troubleshooting, Tips & Tricks

1.41 Future developments and plans

I’m almost done with Recall V3.0, but since I have my hands full with work

to do on my graduate thesis, it may take a while before it will be

completely finished and released... Here are the so-far implementations:

o Will not need MUI anymore :-D Recall will still be fontadaptable and

sizeable, though.

o Multiwindow-environment. All windows are ’multitasking’.

o ALL window-positions and sizes (including the ASL requester), as well as

font, screen, colors, etc. etc. may be saved to disk.

o Recall preferences will remember all sizes and positions when exiting.

o The checker may stay resident in memory (optional) and keep on reminding

you until you quit the program or turn off your machine. Will check the

events every minute (idle time may be overridden with a WAIT-tooltype).

o The checker is a commodity, and may be controlled via the Commodore’s

Commodities Exchange program. (Deactivate etc.)

o Tooltypes support. Here are the most important ones (almost anything
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can be adjusted via the tooltypes):

o FILE=<project>

o LANGUAGE=<language>

o WAIT=<idle time between checking>

o CHECKER=<location and name of the checker utility>

o DOC=<location and name of on-line doc>

o tooltypes to override the settings

o other tooltypes

o Executed programs can be launched either as Shell or Workbench tasks.

Programs started in Workbench-mode will use their tooltypes in their

icons.

o The window of Recall Preferences is an app-window, allowing you to load

projects by dragging the project’s icon over the window and releasing

it.

o Project icon support. Projects saved with icons can be started by

double-clicking on their icons. That way you can put two different

projects on the workbench (with icons) and start them by double-clicking

on them. Taking advantage of the tooltypes, you may have several

project icons pointing to the SAME file, but taking usage of the started

icon’s tooltypes (different language, idle time and different settings).

o Recall can pop up requesters on any screen.

o Cut and paste of events and texts between events.

o Load- and save-modules will replace the converter-program.

o The alerts can be timed out.

o Catchup of events so that you wont skip events anymore.

o New type of event: Hotkey - generates a hotkey-press.

o Possibility to group only certain events, flash certain events etc. etc.

o Recursive directories, allows you to make folders of events i.e. keeping

all birthday-events in a folder called Birthdays. Unlimited number of

levels!

o Possibility to set the stack of executed programs.

o Possibility to set the current dir for executed programs.

o Possibility to set the priority of executed programs.

o Possibility to set a timeout-value for alerts (V39).

o Unlimited number of dates can be attached to the same event.

o Events can now pop up on certain weekdays.

o You can combine weekdays and date, allowing you to make events which

will be shown i.e. the third sunday in a month etc. etc.

o The calendar will put each day on its right weekday in the calendar.
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o Possibility to set the period before or after a specified time.

o Major update of the calculation fields: allowing you to include both the

current date, current time, calculation of days, calculation of years,

current weekday and such in the SAME event! The attributes can be

selected from a listview.

o Lots of new calc-fields...

o Lot’s of other goodies...

---

Other implementations to do:

- Possibility to print the project. Will probably be implemented as an

export module.

- Possibility to generate a list containing the text of all events (with

calc-fields replaced by its value). (Suggested by Per Sverre

Vogt-Hansen)

- Graphical overview of the events within a year or month. (Suggested by

Dirk Böhmer).

1.42 Troubleshooting, Tips & Tricks

The event does not show even if the date and time is set right

Try setting ’Show’ to ’Always’ and try again. The event might have been

run earlier that day... If you cycle through the Show-gadget, Recall

Preferences will reset the daily flag.

The event will not execute!

Recall needs the full path! If for example use the Say-command, you must

enter "SYS:Utilities/say" or else it will not be able to find it.

How do I make an annual event?

Set the date of the event to DD.MM.****, where DD and MM represents the

day and the month you want the event to pop up. Setting the year to

**** is the same as saying ’every year’.

How do I make a birthday event?

There is unlimited number of ways to enter a birthday-event, depending

of how you want the event to be shown. Here’s one suggestion.

(Problem: Remind me of Rebecca’s birthday on 08.05.1970)

Set the date to ’Before’, ’09.05.****’

Set the time to ’After’, ’11:00’

Days=’3’

Repeat=’0’

Text=’Rebecca is {080570} on 8th of May’
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Show=’Daily’

This event will be displayed daily on the 6th, 7th and 8th of May, leaving

enough time to buy her a flower or whatever... (...am I getting soft or

what???).

How do I create events that pop up on certain weekdays?

If you want an event to be displayed every monday, you must first

determine the date of a monday (any monday - last monday will be a good

choice). Enter that day in the date-field and set Repeat to ’7’, and it

will appear every monday from now on...

Testing an event with Show set to ’Daily’

When testing such a project the event will ALWAYS be shown if it has not

been displayed that day. Furthermore will it not show if it already has

been displayed that day. This is inevitable, since Recall Preferences do

not alter the project’s private structure.

How to make events appear both x days BEFORE and y days AFTER a date?

If you want an event to be displayed 3 days before the 10.10.93 AND 2 days

AFTER, you must simply set the date to BEFORE 16.10.93 and days to 5!

When I try to execute a program from Recall it crashes!

When running Recall from the WBStartup-drawer, some programs seem to

cause an out of memory-guru. This is not a bug in Recall! I have only

discovered this error while running ToolManager from WBStartup and

Maxiplan V4.09 (started as an event within Recall) while running under

WB3.0. Other programs might cause similar problems. The solution is

however, quite simple; enter ’Wait 2’ on the line above your program, and

your program will work just fine.

Why not include a new type ’Echo’ which prints the message to CLI

This can easily be done setting the type of event to Execute, and adding

something like this to the list of texts: ’"echo "this will be printed out

in CLI"’.

How do I play a tune while displaying an event?

You have to create two events to do a thing like that (or by creating a

little batch-file to execute). The first event must be of execute-type:

"run >NIL: play birthday.mod". The second event must be of alert- or

requester-type with the desired text. The dates of the two events must of

course be the same.

Annoying shell-windows when executing events

If the executed program echoes a text to the screen or if you use the Run-

command, you should enter ">NIL:" after your commands to suppress any

popping up shell-window.

See also Known bugs
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1.43 History

The Recall version follows the notation <version>.<revision>, meaning that

V2.10 is greater than V2.1. The current version can be printed out using

’Version full Recall’ or by selecting About from the Project-menu in

Recall Preferences.

24.May.93 V1.0

First released version.

25.May.93 V1.1

RecallPrefs used to crash when it loaded an old project and the user

selected ’Use’. Now fixed.

29.May.93 V1.2

RecallPrefs now tries to open its window using the current font set

by the user. If this fails (usually when the window becomes too

big for the screen), it settles for the standard Topaz8-font.

RecallPrefs now uses NewLook-style in menus.

04.Jun.93 V1.3

Recall now only updates the project when it’s absolutely necessary .

This saves a lot of disk-access. Fixed a bug in the compare date & time

header file. Fixed a bug in the purge-function which removed events

with empty dates... Updating the attributes of the event is now

speeded up. RecallPrefs disables the corresponding

(Exact/Before/After)-cyclebutton if Datestring or Timestring are

empty. Made more compliant with Commodore’s Style Guide.

08.Jun.93 V1.4

Oooooops, made a MAJOR mistake by releasing V1.3 too soon! In the

last minute a minor bug was fixed, and this resulted of course in a MAJOR

bug at another location in the program! Selecting ’Before’ or ’After’ with

dates did not work at all... nor did # Days or Repeat every #... I

PROMISE to check more thoroughly in the future... When testing the

project from RecallPrefs, the program asked for a assign called ’REC:’.

Now removed... Recall must be located in your working path.

(i.e. >path work:recall). Fixed a bug which resulted in a ghosted

textstring when editing a line of text...

30.Oct.93 V1.5

Fixed a bug which caused Recall to return a returncode and generate an

error when testing a project from ’Recall Preferences’. Now fixed.

08.Nov.93 V1.6

Fixed two tiny bugs which caused Enforcer hits. Since they where



Recall Guide 25 / 30

positioned in the main loop of both ’Recall Preferences’ and Recall, hits

appeared on every GADGETUP IDCMP and event. Now fixed. (Reported by

Henning Schmiedehausen). Selecting the GetFile gadget when no event was

selected also caused an Enforcer hit. Now fixed. The Add Text gadget was

sometimes not disabled, making it possible to add text to a non-existing

event. Now fixed. Added an extra menu item to save project under default

name without terminating the program. (Suggested by Raoul Rodriguez).

Also, the new archive is better organized with drawers for preferences,

install and documentation. The Installer-script has been rewritten. The

documentation has been processed once again, making (hopefully) easier to

read (all chapter has a right justified margin...).

12.Nov.93 V1.7

The two binaries is now reduced in size. The sources may now be compiled

by double-clicking on the Build-icon in the Source drawer. Added more

tips to ’Troubleshooting’. The installer-script is made more generic and

will also detect if the user already has a Recall project and rename it to

’Recall_OLD.prefs’ when installing new example project. Also reorganized

the .guide, so that the chapters appear in the same order as when using

browse. Corrected a few mistakes and misspellings in the documentation.

Fixed a bug which caused repeating events not to be displayed when they

should. Also, when counting days between different months and years did

not come out right. Now fixed. (thanks to Juha Kallioinen for questions

about weekly events, which led me into finding this bug!)

16.Nov.93 V2.0

This version is re-written from scratch. Uses MUImaster.library for

creating a great looking GUI. Font-adaptable window. Sizable window.

Short-cuts for most functions. IFF-FORM .prefs-file. Possibility to

group events, flash screen before event, automatically delete expired

events, acknowledging events alerts. Confirm actions in Preferences.

Setting the date and time from a ’calendar’. Possibility to copy and

sort lines of text. Better readability and better organized .guide.

Documentation also included in ASCII-format. Unstall-script to delete the

Recall package on your harddisk. Importing and exporting projects of

different formats (may be controlled via the Preferences). More show-

options. More date fields in the same line. Do not use reqtools.library

if not requested. The program may be iconified. On-line-HELP. Although

Recall has gained a lot of functions, it is actually smaller in size!

Optimized code if a faster CPU is available. Much more...

07.Dec.93 V2.1
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NEW All binaries and the installation-script is localized. English,

french, spanish, german, swedish and norwegian catalogs are included.

NEW Speeded up Recall 30%!!!

NEW All binaries has reduced in size! Rewritten to use tiny ROM-routines!

NEW Postponing events! If you put off an event, it will keep nagging you

until you acknowledge it!

NEW Updating event’s attributes is now speeded up (a lot!) in Preferences.

NEW Safer IFF-saving.

NEW Settings menu-item: Confirm executables?

NEW Recall requesters now state the current date in their titles. Uses

the selected dateformat.

NEW Recall uses less memory than before!

NEW Rearranged the GUI a little: The date and time are separated from the

text-group, the getfile-gadget now uses the button-background set in

MUIprefs.

NEW The day-of-the-month gadgets are now of BOOL type (like Time

Preferences).

NEW The calendar can now be controlled from the keyboard.

FIX Events with x days BEFORE or AFTER were not displayed (Reported by

Dirk Böhmer).

FIX Acknowledging alerts did not work, unless ’Acknowledge events?’ was

NOT checked. This bug did not appear when the binaries was not

optimized by the compiler... Strange...

FIX The GUI of the installation-script was messy if you did not use the

Topaz.font (Reported by Heikki Kantola).

FIX The GetFile-gadget did not work! (Reported by Olav Müller).

FIX GetFile did not allocate it’s memory properly.

FIX The GetFile-gadget was not documented.

FIX Purging did not remove all the events that it should.

FIX Corrected several bugs regarding ghosted buttons and the update of

attributes.

FIX One node in the documentation of Recall was not linked properly.

(Reported by Olav Müller).

FIX Recall and Recall Preferences did not deallocate all used memory when

terminating.

FIX Recall crashed if Use ReqTools? was checked but not available!

FIX Events set to whenever or anytime did not show if BEFORE or AFTER was

selected.

FIX The stringgadgets do no longer get activated when selecting a new
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event/text from the listviews, making it easier to use the keyboard

short-cuts.

FIX Recall Prefs no longer asks for a file to import or export when

SYS:Tools/ReConvert is not available...

FIX Changed the name of some items. ’Whenever’ and ’Anytime’ changed to

’Every day’ and ’All day’, respectively. ’Once a day’ has been

changed to ’Daily’.

FIX Enforcer Hit when accidentally loading certain non Recall IFF-files.

FIX All output to shell from Recall will now be routed to the same shell-

window!

03.Mar.94 V2.2

NEW Italiano catalogs included.

NEW Nederlands catalogs included.

NEW SBasePro 4 batch script for converting a database of birthdays to a

Recall project included. Script provided by Thorsten Gau.

NEW Recall only updates the project when the user has selected a button

which alters any of the internal flags. Less disk-access.

NEW The ASL requester now excludes the .info-files.

FIX Recall now handles dates after 30. january 2000.

FIX When displaying requesters with only one button (no Cancel-button),

pressing OK was interpreted as Cancel.

FIX Events of type ’Execute’ were only run once when ’Confirm executables’

was not checked.

FIX You could always cancel an alert, even if the ’Confirm Alerts?’ was

not checked...

FIX Prefs only allocates memory for the Asl-requester when needed.

FIX Fixed a bug in the IFF save-routine, which caused a GURU on some

machines.

FIX Safer IFF-saving.

FIX All binaries reduced in size (again). The checker is now only 8Kb!

FIX Recall used c-lib routines to get and calculate date and time. This

could be quite annoying when running SnoopDOS in the background, as

these functions access ENV:TZ a lot. Switched to ROM-routines

instead.

FIX Recall Preferences did not show events which printed texts to a shell-

window when testing the project.

FIX Recall Preferences would not update the list of texts when the first

event in the list was highlighted, and user opened another project.

FIX Corrected some mistakes and misleadings in the docs.
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The ReqTools.library will not be included from V2.2 and later in a

desperate try to reduce the size of the archive. Anyway, 99% of all

Amiga-owners already have this library...

28.Apr.94 V2.3

NEW Suomi catalogs included.

FIX Better Nederlands translation. Now fits on a 640x200 screen.

FIX Faster rendering of alerts.

FIX Fixed a bug which caused Alerts to crash on some machines. Thanks to

Olaf Seibert for suggesting the byte-split...

FIX The Recall-documentation contained an unknown link. Reported by

Philip Meyer.

FIX The calendar crashed on some machines when using MUI V2.0.

The source will not be included in V2.3 and later in order to reduce

the size of the archive. (Not many were interested in the source,

anyway...)

1.44 Afterword

Send e-mail, bug-reports, comments, suggestions, postcards, A4000 etc. to:

Between 15th of August and 5th of June (every year) I will be available at

the following address:

Ketil Hunn

Leilighet 107

Fabrikkveien 4-8 / Blokk C

N-6400 Molde

NORWAY

or by e-mail:

ketil@lyr.dhmolde.no

In the summertime however, I will be available at the following address

and only by ordinary mail:

Ketil Hunn

Nabbetorpveien 35B

N-1632 Gamle Fredrikstad

NORWAY

no e-mail (you can send e-mail to ketil@dhmolde.no - I may be logging in

from another university during the summer...)

********************************** NOTE **********************************

If you are to report a bug, it is extremely important that you state

which version of Recall you use, what your system-configuration is and
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what programs you launch in WBStartup and your startup-sequence. This

will make it easier for me to locate bugs and problems. It would also be

of help if you mentioned where you got this application.

********************************** NOTE **********************************

Please check ’Future’, ’Known bugs’ and ’Troubleshooting’ before

reporting any bugs!

I hope you agree with me, that this program is the BEST reminder-utility

available for the Amiga. If not, tell my why!

Enjoy!

Ketil Hunn

Molde, March 1994

1.45 68000 CPU or NO harddrive

This version of Recall uses MUImaster.library to create its GUI. Due to

the modular concept of MUI, it takes a little longer to open the first

application that uses the MUImaster.library. Running Recall from a OFS

disk will take a while.

Also, since the management of the layout of the objects requires many

complex calculations, running this application on a "bare" 68000, could be

a bit slow.

If you are using a 8-colour high resolution, interlaced workbench and

think the application seems slow, just enter the MUIPrefs and force the

Recall-package to open on a non-interlaced, 4-colour screen, and every-

thing will go smoother... Change the size and position of the Recall

windows according to your wishes and SAVE it. Change these values as

little as possible, as changing this needs a lot of calculation and will

probably be quite slow at small machines.

Also, the calendar window should be closed when you’re not setting the

date or time, since scrolling through the list of events will be a great

deal slower when the window needs to updated.

Changing the window refresh type and window redraw routine to a type

matching your machine, will also help.

If you still think the application seems too slow, you should either buy a

faster computer or use any version of Recall prior to V2.0 instead...

See also Describing MUI
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1.46 About MagicUserInterface

This application uses

MUI - MagicUserInterface

(c) Copyright 1993 by Stefan Stuntz

MUI is a system to generate and maintain graphical user interfaces. With

the aid of a preferences program, the user of an application has the

ability to customize the outfit according to his personal taste.

MUI is distributed as shareware. To obtain a complete package containing

lots of examples and more information about registration please look for a

file called "muiXX.lha" (XX means the latest version number) on your

local bulletin boards or on public domain disks.

If you want to register directly, feel free to send

DM 20.- or US$ 15.-

to

Stefan Stuntz

Eduard-Spranger-Straße 7

80935 München

GERMANY
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